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Welcome to Photo Express!

Welcome to Photo Express, the new cool tool for expressing your creativity with pictures of
your family and friends! Photo Express is the ultimate tool for adding that extra spark of life to
: your photos — it gives you the power to take ordinary, everyday pictures and turn them into
i high-quality works of art. With its guided workflow and intuitive interface, you'll be printing
! out personalized birthday cards, calendars, and posters in no time at all!

Repair cherished
pictures with powerful
touch-up and clone tools.

e Add captions and
other text on the fly to
personalize photos.

Realistic paint tools
turn any scene into a
--------- | work of art.




Photo Express brings a whole new attitude to photo editing. With its professional-quality ;
templates and easy-to-use editing and management tools added to an all new interface, photo
editing has never been easier or this much fun. High-end tools in a home environment put the
power of a photo studio right at your fingertips.

SEPTENMEEE

Use templates to create outstanding calendars, birthday cards, greeting cards, invitations, and
much, much more! 3
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| Foxton flower show

. Organize and manage all your
digitized photographs with Album.
| Keeping track of your loved ones has

|  NEVET Deen easier.




What's new in this version

This version of Photo Express contains many new unique features designed to make photo
editing that much more fun and intuitive. Some of these features are:

Internet capabilities — Download your
developed photos from an online photo : f.ﬁ Share photos with

service, or send your creations to friends an friends via e-mail or
family with e-mail using DirectConnect over the Internet.

technology, or create Web pages complete U
with music and thumbnail images.

Album — Your one-stop resource for orga-
nizing photo collections in your computer by
author, title, date, and more. Create albums
for special events, vacations, or special
occasions. Manage your photos and cata-
logue them all from within Photo Express.

| Fodton flower show

Improved interface — Photo Express sports ¢ 1 . Use the.built-in album
' | feature in Photo

| iti .
an al! new Iool.<. Intu!tlve and easy.to use, th(;._i = 1 Express to organize
new interface is designed for maximum i yOUur images.
efficiency and fun.

Smart Technology— Photo Express’ Smart Technology makes photo editing that much easier!

* SmartTemplates maintain individual settings for each template object.
* SmartCalendar automatically updates calendars posted as desktop wallpaper.

* Connect automatically to the Ulead website by clicking the earth icon on the Toolbar for tips,
tricks, and more.

* Use the extensive PhraseBank built-in to the Text tool for adding that perfect message to
images.

* SmoothZoom gives you continuous zooming when you're in Project mode to quickly
navigate in and out of your photo.



Getting started

To install Photo Express:

1 Place the Photo Express CD into your
CD-ROM drive.

2 When the Setup screen appears, follow e
instructions to install Photo Express onto yo
computer.

Oy
PhotoExpress

E:—" Note: Ifthe Setup screen doesn’t appear

.| afterloading the CD, then you can manually
start it by double-clicking the My Computer
icon on your desktop, then double-clicking
the icon for the CD-ROM drive. When the
CD-ROM window opens, double-click the
Setup icon.

Once you've installed Photo Express, next
take a moment to register online. Just point
your web browser to the Ulead web site
(http://www.ulead.com Becoming a
registered user entitles you to product
updates, update information, and technical
support should you have any problems with
the Photo Express program. When you run
Photo Express, make sure you switch to
800x600 or 1024x768 resolution, and HiColor
(15/16 bit) or True Color (24 bit) mode.

“iz To run Photo Express:
=== e Double-click the Photo Express icon on your Windows desktop.

* Or select the Photo Express icon from the Ulead Photo Express program group
on the Windows Start menu.

r

b e
"= Tip: Remember, if you get really stuck while running Photo Express, you can always
‘ use the Help button found on the Shortcut bar. Simply click the button and when your
mouse cursor changes, click on the option or tool you don’t understand.




Overview

Photo Express takes you through the entire process of editing your photos from beginning to
end. There are two ways you can work in Photo Express: Photo mode or Project mode. Photo
mode is like a developer’s studio — it’s here that you bring in raw images and enhance them,
tweak them, clean them, and add amazing effects to them. With the tools presented in Photo
mode, you can do almost anything to your photos.

Project mode, on the other hand, is ‘template-based’ editing. We provide you with a series of
professional-quality templates that contain preset images, text, and effects, and you modify
and customize them to suit your own needs. Each template is fully editable, and the changes
you make are remembered the next time you use it. Templates are the fast and fun way to take
photos and turn them into exciting greeting cards, birthday cards, name cards, invitations, and
anything else you can imagine.

Getting photos

Photos can be brought into Photo Expres! .
albums in different ways:

* Open an existing image file or download it
from the Internet. _—

* Digitize photos using a scanner, a digita (%‘ - i)
camera, or a video source. j T

Editing

This is the next step in the process. After
opening a photo into the Workspace you can:

* Crop, Resize, and further
adjust a photo’s dimen-
sions, color, lighting,
and focus. &
* Add text to personalize
images, or add high-end
special effects to stun ﬂ“""
your audience.

I




Printing

Once you've finished editing,
print your photos:

* Print a single photo to a page, tile-print
them to make name cards, or poster-pH#!
them to make large posters.

* Print album thumbnails to create photo
catalogues.

Sharing

Send photos you've enhanced to friends and
family using a variety of methods:

¢ Save them to disk and pass them on this
way.

* E-mail them to people you know whom are
connected to the Internet.

« Fax them to colleagues at the office.

e Generate HTML-based web pages and send b
them to friends as interactive slide shows.

EXxpress extras

Have a little fun with your photos using
Express extras:

* Create self-updating Windows desktop
calendars for keeping track of special
events and occasions.

¢ Qutput exciting morph animations.
* Make cool slide shows and screen sav

« Save a photo or project as Windows
desktop wallpaper.




Photo Express at a glance

All editing and creating in Photo Express is done from a single screen. Below is a guide to all
of the main elements of the program window.

Options panel

Workspace

Toolbar

Ulead web

Fhoto

Global Viewer & Thumbnail scroll

Command panel Shortcut bar

Mode tabs




» TheMode tabs switch Photo Express between Photo mode and Project mode.
Photo mode is where the majority of your work is done, while the Project mode
lets you make greeting cards, name cards, and other fun things based on templates.

*  TheCommand panel lists all of the
available categories in Photo Express
necessary for getting the most out of your
creativity when working on photos. Each
category contains a specific set of tools.

« TheOptions panel shows you all the
different options available for any given
tool.

o lE. . L R N
|
» TheToolbar contains all of the tools you need to edit your photos. Each group of tools is

divided into categories — when you select a new category, the tools on the Toolbar change
accordingly. Categories can be selecig?

from the C(;mmand panel. i;g.;l :&l E E 3 E

» TheShortcut bar makes available to you all the most commonly used menu commands.
These commands vary depending on the Command panel category you are currently in.
Click the green arrow to hide the

Shortcut bar. q4 BB Qv L5 N2

e The Thumbnail scroll opens from the
Global Viewer and lists all the images you
currently have open with the topmost
image displayed in the window below the
Command panel.

e TheWorkspace is where your photo is
placed as you work on it.




Getting photos

The first thing you want to do when you start Photo Express is get the photos you want to
work with into the actual program. The place you start is with Aloum. From here, you can do
almost anything in Photo Express. All other ways of getting photos can work independently of
Album, but they are also set up to let you capture or open images directly to it.

= Note: The Project tab only allows you to open Project Template files (*.tpx and *.tpl) — for informa-
“| tion on adding photos and other images to the template, please see the Editing section.

Working with Album

Album lets you organize the photos in your
computer into convenient ‘books’ similar to
real-world photo albums. These books
contain thumbnails of all the images you
select to put in them, as well as links to said
images, information, and annotations. This
way, you have instant access to all your
photos from directly within Photo Express.
Organize photos by author, subject, title and
catalog.

[

To create a new Album:

1 Click the Get category button on the
Command panel.

Select Album from the Toolbar. = SRR ...~ N
Click the New button in the Options panel. nen ot
The New Photo Album dialog box opens " = -
and you can set up the new album file. B [ rettg ity
R | Era |
-:.._ T
TR 1Y ol W W




To add new images to an album:
1 Select an album. i

2 Click the File icon and browse for the
folder where the images are stored.

3 When they appear in the Options panel,
click the Select All button (or select
images individually by holding down the
Ctrl key as you click them).

4 Next, select th&ave to albumoption ':_;__.*_1:
and click the Insert button. The files are
added to the last album you had open. o

over the album in the Options panel and

all g o ; ‘ . : :
i ‘}r Tip: To relink ‘lost’ images, right-click
select either Relink or Refresh.

Printing album thumbnails: '_..---';-

1 Click the Album icon on the Get toolbar .'r'-;.' ;
and then choose an album from the ok
Options panel.

2 Press the Ctrl key, and in the workspace,
click the thumbnails you want to use. The £
selected thumbnails are highlighted in green.

3 Click the Print button on the Command i
panel and select a print method. i

&, . < Tip: You can jump immediately to the Print
9 option you want to use by hovering your £
pointer over the Print button on the s
Command panel. When the submenu e
appears, click the Print icon you want. ;




To get photos from a digital camera: =
1 Click the Camera icon; the Options panel (&‘

changes to display a list of sources.

2 Select the source that matches your digital
camera.

3 In the File name box, enter a file name for
your captured image. If you are down- :
loading multiple images, then each image
is prefixed by the file name you specified
and followed by a sequential number (i.e.
0001, 0002, and so on). &

4 Next, select the file type you want to save
the image as.

Before and after
brightness & contrast
post-processing
applied

5 Finally, when you're ready, seleSave to
album and click the Acquire button.

s Tips:

‘. ® Select the Apply post processing option
to open the Post-Processing Wizard.
This automatically helps you correct
common scanning or capture errors
such as alignment, color balance, and
size.

® |fyou have many high-resolution

images, then choose a file type that
uses compression (such as JPEG) in
order to reduce file size. Otherwise, you
can choose uncompressed file types
like BMP or TGA.

Before and after color
balance post-processing
applied



To capture frames from a video source:

1 Click the Import button on the Toolbar
and select a source from the Import
Module options.

Note: You must have the appropriate
drivers and a capture card installed on

your machine before this can work. For
more on how to use your capture card and
drivers, please refer to the accompanying
documentation.

2 Define the file type you want to save each
captured frame as, and enter a file name.

3 Once you've set your capture options,
click Import.

To sort thumbnails:
1 Select an album.

2 On the Shortcut bar, click one of the sort
buttons to change the method by which
album thumbnails are displayed.

Namesorts thumbnails alphabetically.

Date organizes thumbnails based on the
Date field entry.

Size sorts them according to file size.
Type arranges thumbnails by file type.

-t Ls_ Tip: You can change the viewing mode of
\2’ thumbnails in the workspace by clicking
the Display button on the Shortcut bar.



: Adjusting photos

After you’'ve acquired an image from a scanner or digital camera, chances are it's going to
need some adjustments. Not all scanners digitize images with perfect horizontal and vertical
" alignment, and it can be difficult to place some images perfectly straight on a scanner. Photo
i Express provides you with the perfect tool for straightening your photos: the Transform tool.

To re-align a photo:

e 1 After scanning the photo, open it from
_:;::: 5 either Album or from File directly into the
T workspace if you haven't already scanne: :
2 : it directly there. '

2 Put your mouse over the Edit category
button and select Adjust from the pop-up
submenu. The Adjust tools appear on the
Toolbar.

3 Click the Transform button on the Adjust
7o toolbar. The Transform options appear in
ok the Options panel.

e * To freely rotate a photo, select the spin
A wheel in the upper right or lower left
corner of the photo and rotate into
position.

s * To position it more accurately, enter an =
: order of degrees in the Options panel anc
then click either Rotate Left or Rotate
Right to implement it.

g * To flip the photo, click either Flip
S Horizontally or Flip Vertically.

transformation by clicking and dragging
the handles on the upper left or lower right
corners. You can also move the image in
the workspace by dragging it with your
mouse cursor.

: ala . . .
i — \; - Tip: You can re-size an image during




To trim your photo:

1 Click the Trim button in the Edit: Adjust
category. This opens the Trim options in
the Options panel.

2 Select a Trim shape and then set the
amount of Soft edge you want to soften
the edges of the trimmed photo with.

3 Click Apply to trim the photo.

Note: You can open the trimmed region in a
new editing workspace by selecting the
Create New Image option.

E

To re-size your photo:

1 Click the Size button in the Edit: Adjust
category. This opens the Size options in
the Options panel.

2 Select either a predefined size from the

Standard drop-down menu, or enter

::z::Sizem' __ custom dimensions for the image in the
' User defined option.

hioto Size 3% Sin |

Mame _Eard 91 H.5 o ;
|Cord Size J48x 105 em | 3 Select the Keep aspect ratio button to

o ;. maintain continuity between height and

367501 215 - width as you resize. This keeps the image

L from getting stretched unnaturally.

4 Finally, you can define the image’s
Resolution. This determines how the
image prints on paper - the lower the
resolution, the less pixels used to generate
the image, while a higher resolution uses
more pixels to create an image with
larger pixels.

5 Click Apply to resize the photo.




& Retouching photos

Four tools in the Adjust category let you quickly retouch flawed images that were damaged
either when they were taken or when they were scanned into your computer. These tools let
you change the fundamental properties of a photo.

To adjust the focus on a photo:

1 Click the Sharpness icon on the Edit: {
Adjust toolbar. The Sharpness options aré-
displayed in the Options panel.

2 You can select from the preset Sharpness
adjustments by double-clicking or dragging
a thumbnail from the Presets tab onto the
photo, or you can click the Custom tab to
do it manually.

3 On the Custom tab, adjust the Strength and
Radius sliders to adjust the focus to where
you want it. When you have it set to the
desired levels, click the Apply button.

when manually adjusting the properties of

.,‘\;', Tip: Use the preview image as a guide
a photo or when adding effects.

To adjust the lighting in a photo:

1 Click the Lighting icon on the Edit: Adjust h
toolbar. The Lighting options open in the
Options panel.

2 Drag and drop the Lighting presets on to
your photo or adjust the Lighting manually
by clicking the Custom tab.

_" : 3 On the Custom tab, adjust the Brightness,

Contrast and Gamma sliders to adjust the
lighting to where you want it. When you
have it set to the desired levels, click the
Apply button.




To adjust a photo’s color balance:

1 Click the Color Balance icon on the Edit:
Adjust toolbar. The Color Balance options
are displayed in the Options panel.

2 Select either from the preset Color Balance
adjustments or use the Custom tab to re-
adjust the Color Balance by hand.

3 On the Custom tab, adjust the color sliders
until you get the Color Balance where you
want it. When you have it set to the
desired levels, click the Apply button.

To remove redeye from a photo:

1 Click the Touch-up icon on the Edit:
Adjust toolbar. A tool drawer opens below
the Toolbar — select the Redeye tool.

2 Set the brush size on the Options panel.
This defines the stroke size when the
brush is used on the image.

3 Set the source tolerance. The higher the
tolerance, the wider range of color you
can remove.

4 Under Remove options, select the
Remove Redeyeoption.

5 Using the brush, click and drag in the
affected eye to remove the red pigment
from the person’s pupil.

B! ‘wi, Tip: You can also use this effect to change

“. a person'’s eye color from their natural eye

color to another color entirely by selecting
Change eye’s color.




Working with selections

In Photo Express, you need not use the entire photo as a canvas for editing. You can also
make specific selections and work only within them. Selection areas can also be used to create
‘objects’ which can be moved around, positioned, warped, edited and otherwise changed
independent of the rest of the photo.

To make a selection area:

——————————————————

.‘i‘ﬂ'. = .1 _-f L s :.

1 Click the Edit: Selection submenu button
to open the Selection tools on the Toolba

T

;71{, 2 Choose the tool you want to use to make
i the selection.
i * Shapecreates basic polygonal : :
3;": selections. e
?ﬂ:‘ * Trace draws freehand the shape of the [ AR
i*"": selection.
é%}a * By Color selects a specific color or
;;.:_.}:_-_%_E- range of colors and then select all the
el pixels in the photo that match that.

3 Draw your selection area on the photo.

i, : «_ Tip: Drag the selection area with your
\; mouse cursor to turn it into an object.

Objects can be moved independently of
the original image, and layered using the
Object Level buttons on the Shortcut bar.
Clicking the Up button moves an object up
one level, while clicking the Down button
moves an object down one level. An
object’s level is determined by the order
in which it was created in relation to the
other objects in the workspace.



Painting photos

The Paint category contains some of the most useful tools in Photo Express — paint brushes, \_
cloning brushes, and retouch tools. These tools let you take an ordinary photo and turn it into
a work of art. Paint lets you add to the existing scenery, sign your name, or even recolor oo

elements. L

To use the Paint tools: : 3

1 On the Edit: Paint toolbar, click the Brush
icon. A scroll opens revealing the different i
types of brushes available. Select a brush )
type, and the Options panel displays that :
brush’s attributes. i

2 Define the brush tip style by clicking the R
Shape icon. The Round shape is good for
mimicking real-world pens and brushes, Rt
while the Line shapes allow you to make
calligraphic-style strokes.

T Ry
st Frl

3 From the Options drop-down, select a
drawing style.

4 Define the brush head in the Size box, and
the pigment of the paint to apply to the ot By
image. 3

5 Finally, set a transparency level and soft i
edge for the paint. This determines how He
strongly the paint is applied to the photo. 3

6 Once your brush has been configured,
begin painting. i

i ‘:r Tip: To undo mistakes or retouch painted .

‘9 areas, click the Eraser icon in the Options il
panel to turn the brush into an eraser.




Cloning people and things

Photo Express’ Clone tool is a powerful utility for adding additional people and props into a
photo that weren’t there originally when the picture was taken. It combines the functionality
of the paint tools with the technology to paint from one picture into another.

To clone people and objects:

1 Open the photo you want to clone into to
the workspace. This is yolnase image

2 Next, open the image you want to clone
from into the workspace. This is your
clone source

3 Click the Edit button on the Command
panel, then click the Paint button on the
submenu. The paint tools appear on the
Toolbar.

i, . v Tip: You can keep track of your images by
\; clicking the Thumbnail scroll. When the
preview strip unfurls, click the image you
want to switch to and it opens in the
workspace.

4 Select the Clone tool; when the drawer
opens, click one of the brush styles.

5 On the Options panel, under the Source
tab, select your clone source from the
Select photo thumbnail list.

6 Move the crosshair in the preview win-
dow to the position you want to start
cloning from.

7 Finally, move the cursor to the workspace
and start painting on the base image — the
cloned person or object is gradually
‘painted’ into the scene.




Working with text

Text is a great way to liven up any photo. It's a quick, and certainly easy, way to make
postcards, greeting cards, invitations, and birthday cards on the fly using friends and family
for that extra special touch. You can also add amazing text-only effects to the phrases you
place on your images.

To add text to a photo:

1 Click Add/Edit button on the Edit: Text
toolbar. The Add/Edit text options appear
in the Options panel.

2 Enter the word or phrase you want to add
to the photo in the Text box. By default,
the text is all placed on a single line. Press
Enter to create two or more lines of text.

3 Use the Text Style, Alignment, and Fill
options to further enhance the text you
wrote.

4 Click the New button. The new text is
added to the photo.

[t a boy!

Liam Duawinl
24 May 1998

-t Tips:

‘ ® You can edit existing text as many
times as you want simply by selecting it
in the workspace while using the Add/
Edit text tool. When finished editing,
click the Update button rather than the
New button.

® To permanently join text with a photo,
right-click over the text object in the
workspace and select the Merge
command from the pop-up menu.

® You can re-arrange multiple text-
objects by using the Object level
buttons on the Shortcut bar.




To add fire to text:

=

To add a shadow to text:

__\;’, Tip: To create a halo of fire around a text

Select a text object.

Click the Edit: Text submenu button to
open the Text tools.

Select the Effects icon on the Toolbar.
The Effects drawer opens. Scroll the
drawer to Fire and click it. The Fire
options appear in the Options panel.

Select a preset and click Apply. The text is
transformed to fire in the workspace.

object, select the object and copy it, then
follow steps 1-4 above. When the second
object becomes fiery, move it over the
original text object to create a fire halo.
Pnfe = e 1_541'1;;.

JNAEL B

Select a text object.

Click the Shadow icon on the Edit: Text
toolbar. The shadow options appear in the
Options panel.

Adjust the position of the shadow in the
Shadow position preview box by sliding
the horizontal and vertical position sliders.

Adjust the Color, Transparency, and Soft
edge of the shadow.

Click the Apply button. The shadow is
added to the selected text object.



Special effects

Special effects are the icing on the cake for photos — not necessary, but indeed an exciting a'ﬁ_'
fun addition to what you normally could do with your images. Effects such as Warp, Puzzle, ":5_-"-::_53
Artist Type, and Emboss can make good images even better, while other effects such as Colo.
Focus and Lenses can draw out some of the more subtle qualities of a photo. 3

To turn a photo into a painting:

1 Click the Edit: Effects submenu button to
open the Effects tools on the Toolbar.

Select the Artist Type icon.

When the Artist Type drawer opens, select
a painting style.

4 Select a preset and click the Apply button.
The Artist Type effect is applied to the
image in the workspace.

create some truly unique images. For
example, use the Edit: Adjust - Sharpness
tool to draw out the lines in a photo, then
apply the Watercolor effect. This makes
the colors stand out even more.

;\;' Tip: Combine this effect with others to

To add motion blur to a photo:

1 Click the Lenses icon on the Edit: Effects
toolbar.

2 From the Lenses drawer, select Motion
Blur. The Motion Blur options appear in
the Options panel.

3 Select a Motion Blur preset and then click
the Apply button. The selected effect is Pl
added to your photo.

3 L < Tip: Use the Custom tab to change the
\9 angle and blur offset.




To add bubbles to a photo:

1 Click the Particle effects icon on the Edit:
Effects toolbar.

2 From the Particle effects drawer, click the
Bubble icon. The Bubbles options appear
in the Options panel.

3 Select a preset and then click the Apply
button. The bubble particles are added to
the image in the workspace and merged.

i, - v Tip: To control the position and size of the
\J bubbles, click the Custom tab.

Other effects you can do in Photo Express:

Concrete

Valemtines qu-‘




Printing photos

Once you've put the finishing touches onto your photos, it's time to print them out. Photo
Express contains numerous printing options, letting you output posters and name cards in
addition to its regular printing duties.

To print an image:
1 Select the image you wish to print from _ﬁ'

the Thumbnail scroll, or select an image v

LG CEREETR N -

or images from an available album.

2 Click the Print button on the Command
panel. The print tools appear on the
Toolbar.

3 Select a print tool to use.

* Normal lets you print images normally
on various different types of paper (from
Letter to A4 to envelopes).

* Tile resamples the image down to tile it
multiple times on the page, creating
custom ‘picture cards’ or postcards.

* Posterresamples the picture up,
allowing you to print portions of it on
separate pieces of paper effectively
creating posters and banners.

4  Click Print.

! ‘..!f, Tip: You can also print album thumbnails.
~. For more on this, see page 13.




Saving photos

After work on your photo is complete, you'll want to save it. In Photo Express, you can save
a photo in a variety of different image file formats. Each file format has its own unique
properties and characteristics. Some formats, however, are better than others for specific
situations, such as saving for the Web are.

To save a photo:

1 Click the Share button on the Command
panel. The Toolbar displays the different
Share tools.

2 Click the Save button on the Toolbar. The
Save options appear in the Options panel.

3 Enter the location, name, file type, and
data type.

4 Select an album from thHgave to album
drop-down menu.
Click Save.

o

=

a1

-.i', Tips:

‘. ® Data type describes how much color
information the image is saved with. The
more color information included in the
file, the larger the file tends to be. The
highest color data type is True Color
and files saved with this data type can
be very large. Indexed-256 and
Grayscale each contain up to a
maximum of 256 distinct colors and
generally are quite small.

® Some file types you can use are: BMP
for saving your photos at the highest
level of quality with no compression;
JPEG for photos you want to use on the
web or send via e-mail - it compresses
photos down while retaining its overall -
quality; UPX for saving photos with The same image in Truey
unmerged, free-floating objects. These Color, above, and
objects can be used again when the file Indexed-256 color, right. «=
is re-opened.




E-mailing photos to family & friends

In addition to storing images on your hard disk, you can also send them to friends and family.
This is a great way of keeping in touch with long-distance relations and is an environmentally
friendly alternative to re-printing images at a photo developers.

To send an image via e-mail:

S F [
e e 1 Select the image you want to send from
the Thumbnail scroll or select a series of

images from an active album.

2 Click the Share button on the Command
panel. The Share tools appear on the
Toolbar.

3 Click the E-mail icon on the Toolbar. The
e-mail options appear in the Options panel.

4 To send more than one image in individual
mails, select th&end separate mails
option. Otherwise, by default, all open
images are sent in the same mail (this is
not recommended in order to reduce
download time).

5 Click the Send button to send the images

on their way.
Left, JPEG
format with _n Ilﬁ' Tip: Images are sent as JPEGs, an
S average ~. Internet-friendly file format that compresses
i " combression images to the smallest possible file size
P - while at the same time retaining their
Above, JPEG

overall quality. However, this is not a
format with no g # completely lossless process so photos will
compression. T S not have the same level of quality as the

{ originals.

Right, JPEG
format with high
compression.




Faxing photos

Another great way of sharing photos with family, friends, or even co-workers is by faxing
them. They make a great surprise invitation, impromptu birthday card, or spontaneous greeting
card.

To send an image via Fax:

1 Select the image you want to fax from thq i
Thumbnail scroll or select a group of
thumbnails from an album.

2 Click the Share button on the Command
panel. The share tools appear on the
Toolbar.

3 Click the Fax icon on the Toolbar. The
Fax options appear in the Options panel.
E Note: You must have Microsoft Fax

installed before you can send an image by L L, -
this method. '

4 Set the layout of the image on the printed |
Fax page. '
* Fit to page forces the image to fit in its
entirety on a single page.
* Center horizontally andCenter
vertically centers the image relative to the
page margins.

5 Click the Setup button to set up your Fax

parameters if necessary. This opens the
Microsoft Fax software’s dialog box.

6 Click Send.




Making web pages

Finally, one of the coolest ways to share photos with people is by outputting them to HTML

web pages that you can either send via e-mail or post to a website for the whole world to see
and enjoy. :

To put an image on a web page:

1 Select the image you want to use from the m_
Thumbnail scroll or select a range of ;
thumbnails from an album.

2 Click the Share button on the Command
panel. The share tools appear on the
Toolbar.

3 Click the Web page icon on the Toolbar.
The Web page options appear in the
Options panel. These options let you create
a new Web page with a thumbnail of the
selected image or images. Each image is
linked to a full sized version users can
view simply by clicking the thumbnail.

Define the page’s layout.

5 Once you've finished setting up your new
web page, enter the folder you want to
save it to in the Output folder box on the
Basic tab, set the Destination to Disk, and
click Apply. The HTML page and any
associated files are saved to the folder you
specified.

i, e Tip: E-mail your web pages to a friend by
selecting To Mail from the Destination drop
down menu. Web pages sent by e-mail are
bundled in self-extracting executable files.
This file can be unpacked by double-
clicking its icon. The executable file is
saved in the folder specified in your e-mail
program to save attachments in.




One of the easiest tasks to accomplish in Photo Express is making calendars, either for your
Windows desktop or for your real desk top. They are great for keeping your loved ones close,
in addition to being a convenient way to keep track of important dates in style.

To create calendars:

1 Get the image you want to use as the
calendar image.

2 Click the Express button on the Command ﬁ <3 EJ @ 'E'I
panel and then select the Calendar icon | '
from the Toolbar.

3 Choose a type of calendar from the
samples and modify it to fit your needs.

Click and drag the photo or date object to
move it. Or, resize it using the control
handles on the image’s border.

Edit text and dates by selecting the object
that contains it, then click the Planner ; 8
button on the Shortcut bar to add notes or Y i | by | "~
holidays to individual dates as well as add
props from the Clipart box.

4 When your calendar is ready, set it as
Windows wallpaper by clicking the
Wallpaper icon in the Options panel, or
send it to the Windows clipboard (to paste
it into other applications) by clicking the
Clipboard icon. Finally, print the calendar
by clicking the Print button.

_*%r_ Tip: On the Shortcut bar, click the
\. Command Menu icon to open the Calendar
Command Menu. This is where you define
the properties of the calendar, such as
font, colors, and text style, among other
things.




Daily planners can be made on the fly, using the calendar command with some slight modifica-
tions. Use them at school to organize class schedules, or at work to make appointments. Like
calendars, you don’t even need to print them out — drop the planner onto your desktop and
your weekly schedule is only a mouse-click away!

To create a daily planner:

1 Get the photo you want to add to your
planner, then click the Express category
button on the Command panel.

2 Click the Calendar icon on the Express

{Jazen-ar26 :" :f toolbar.

Click the 7-day tab in the Options panel.

4 Set the week you want to use for the daily
planner.

5 Click the Planner button on the Shortcut
bar. The Planner dialog box opens.

6 Add notes to specific dates by clicking
that date’s number in the Planner dialog
box. You can also add clipart to signify
holidays and define permanent holidays
specific to your family, region, or culture.

LE I8 ] e e -
J Noweher 1998 | T[] 7= W x :I 7 Click the color boxes at the top of the
Mt e i T R ‘ Planner dialog box to customize note and
O holiday colors.
B R L 5 8 Click OK when you're finished. When you
o T T TR T T I T T return to the Calendar Options panel, you
. — .‘F can either print out your new planner, save
; n 3 54 5 S it to the Windows clipboard for use in
TR ML other programs, or turn it into Windows
. TB’” T ﬁll wallpaper.
Delete Holiday v |




Morphing photos

One of Photo Express’ more novel effects extras is that of image morphing. Morphing
transforms an image over time to create interesting and unique ‘warps’ of the original photo.
Image morphs are output as either image sequences or animated GIF files.

To morph an image:

1 Get the photo you want to morph from ar.
album or from your hard disk.

2 Click the Express button on the Command
panel. The Express extras appear on the
Toolbar.

3 Select the Morph icon from the Toolbar.

Choose a transformation frofiype. To
use the transformation, move your mouse
cursor into the workspace and start
‘painting’.

5 On the Shortcut bar, click the Add Item to
Storyboard button. This adds the current
image to the Storyboard.

transformation and return the image to its
original state by clicking the Restore
button on the Shortcut bar. Also, click the
Play button to view an on-the-fly rendering
of the animation.

b o
- \;_ Tip: You can remove the effects of a

6 When your Storyboard is complete, save
the file to disk by clicking the Save icon
on the Shortcut bar.

Note: You can output image morphs as
either an image sequence or GIF anima-

tions. GIF animations are useful for putting
your images on the Web while image
sequences are best for searching through
the individual frames to find the one that
really stands out.




Making screen savers

1

To make a screen saver:

_\_‘\:'_ Tip: Use the Slide Show feature on the

In Get mode, select a series of images
from an album. Press the Ctrl key as you
click on the thumbnails to add them to
your selection. Selected thumbnails are
highlighted in green.

Click the Express button on the Command
panel. The Express extras appear on the
Toolbar.

Select Screen Saver from the Toolbar.
Set the Transition effect to Random.

Enter a delay of 5 seconds. This is the
length of time each image is displayed on
the screen before cycling to a new image.

Select theResize large images to fit i
screen sizeoption. {

Click Apply. The next time Windows
engages a screen saver, it will use the one
you just created. ;

Express extras Toolbar to create more fully
featured image catalogues than the Screen
Saver tool can provide. These can be
browsed at the viewer’s leisure.



Photo wallpaper

Photo Express lets you save photos as Windows Desktop Wallpaper. This is a great way to
customize a specific user’s desktop with images of the ones they hold close to their heart
There’s no better way to personalize your computing work environment than by adding
pictures of your children or parents to the desktop!

To make photo wallpaper: %

1 Get the photo you want to use from eithe] e
an album or from file.

2 Click the Express button on the Command
panel. The Express extras appear on the
Toolbar.

Select the Wallpaper icon on the Toolbar.

ChooseCenter from the Display drop-
down menu.

5 Click theFit in window option to force fit

the photo to the dimensions of your
screen.

6 Click Apply.

of how your photo will look when set as

;‘;“*_ Tip: Use the preview monitor to get an idea
desktop wallpaper.




The Project mode gives you a focused environment in which to create custom greeting cards,
calendars, invitations, birthday and anniversary cards, name cards, and planners. The Project
mode is useful for getting through a ‘project’ as quickly and efficiently as possible. It is where
Photo Express lives up to its name, speeding you through all the necessary tasks while keeping
all the unnecessary or extraneous components secure in the background. While in Project
mode, you can only open template files, but you can add photo files of any image type to your
templates in the process of customizing them.

To begin a new project:

1 Click the Project tab when you start Photo
Express. Photo Express then switches
over to Project mode, which contains
slightly different options and commands
than Photo mode.

2 Click the album icon on the Toolbar and
then select an album from the Options
panel. Albums are categorized by type,
such as Flyers, Greeting Cards, and
Invitations to name a few.

3 Choose a template from the album and
click the Edit button on the Command
panel. The template opens into the
workspace.

__= E.i, Tip: You can create your own, custom
templates in Photo mode. All you need to do
is set your template up (i.e. add text objects
and artwork) and then save it as a *.tpx file.
This file can then be opened in Project
mode and saved to one of the many Project
albums or added to a custom album.




Photo Express’ unique templates can be edited and customized to suit your own needs.
Templates consist of multiple components, usually a combination of text and photos with a
decoration or two perhaps thrown in. To change any one of these components, simply select it
and choose the appropriate tools from the Toolbar.

To replace images in a template: W
1 Click the Edit button on the Command ‘\;
panel. When the submenu opens, click

Place. The Place tools appear on the i ——
Toolbar. e =

Click the Album icon.

In the Options panel, select the image you
want to insert from an available album. T T

4 Click Replace.

already open in the workspace. Simply
click the Workspace icon on the Place
toolbar and select the image you want to
add to the template.

__::*, Tip: You can also insert images that are

To move one object over another:
1 Select the object you want to shift up.

2 Click the Move Object Up button on the
Shortcut bar. This moves the object up ik
one level, placing it above and over objectsh-%fi -
lower than it in the hierarchy. L

_* % Tip: Use the Move Object Down button to -
\2 place the object below other objects. ;-ﬂfj




To zoom in and out on objects:

1

-

To transform text objects:

1

-

Click the SmoothZoom icon on the
Shortcut bar while in the Edit category.

In the workspace, click the left mouse

button to zoom in. SmoothZoom technol-
ogy lets you continuously zoom as long as
you press the mouse button. To zoom out,
press the right mouse button. |

workspace and drag, forming a selection
box. When you release the mouse button,
Photo Express zooms specifically into the
area you selected.

'ﬁ, Tip: To target a specific area, click in the

While in the Edit category, click the text
you want to transform.

Click the Text button in the Edit submenu
on the Command panel.

Click the Transform icon on the Toolbar.

In the Options panel, select a transforma-
tion, such as Perspective.

Using your mouse cursor, grab a
transformation handle on the selected text
object, and proceed to warp it.

= e Tip: This effect works really well when
\2, used together with the Text: Shape tool.



One category of tools on the Edit menu in Project mode is unique to that tab: Decoration.
These are special, object-based effects such as Frames, Edges and Props you can use to
enhance photo objects in a project.

To add special edge effects to a photo objed
1 Select a photo object.

2 Click the Decoration button on the Edit
submenu of the Command panel.

3 Click the Edges icon on the Toolbar.

From the Edges drawer, click the Magic
icon. This opens the Magic Edges options
in the Options panel.

5 Select a Magic Edges preset and click
Apply.

5 ! « . Tip: You can create unique Magic Edges
\J by clicking the Custom tab in the Magic
Edges Options panel.

To add frame to a photo object:

1 Select a photo object.

2 Click the Frames icon on the Toolbar.
3 Select a frame from the Options panel.
4 Click Apply.

Note: You cannot apply frames to a
“| background image.




To add special backgrounds:

1 Click the Decoration: Background icon on
the Toolbar.

2 Select a background image from the
Options panel.

3 Click Apply.

_* % Tip: You can define how a background
\2 image is tiled in your template workspace.
Center fits the entire image into the area;
Tile repeats the image over and overin a
regular pattern; and Color fills the area
with a solid color instead of an image.

To add props:

1 Click the Decoration: Props icon on the
Toolbar.

2 Select a prop category on the Options
panel. The props for that category appear.

Select one of the clipart images.
4 Click Apply.

image, right-click over it in the workspace
and select the Remove Shadow option. You
can restore the shadow by clicking the
Shadow icon on the Decoration toolbar.

__?‘_ Tip: To remove the shadow on a clipart




Printing templates

As with Photo mode, Project mode lets you print your work when you're finished with it. The
same options available in Photo mode apply in Project mode as well. For more on printing, see
page 27 and the online help.

To print a template as name cards:

1 Click the Print button on the Command
panel.

EPSOM Stplus COLOR 800

Letter 81/2 % 11 in

3 BA™

2 Select the Tile icon from the Toolbar. The
Tile options appear in the Options panel.

3 Enter the number of rows and columns.
This establishes how many name cards
are printed per page.

4 Select your printer from the Printer name
drop-down menu.

5 Select the paper size you want to use from
Paper size drop-down menu.

6 Click Print.

cul LY Tips: | e E—]
q. ® To further define the layout of the name [ S = } ! —
cards on the page, click the Options |3 - ]
button. This opens the Layout options

dialog box, giving you control over such | s
things as X- and Y- offset, spacing, and | z ey !
image size, among others. Kt s s imna J
® To setup your printer options, click the | b s
Printer Properties icon on the Shortcut [ z T ! T

bar. |! o ! .




Sharing templates

Sharing templates works exactly the same way as sharing photos in Photo mode. You can
print, e-mail, fax, or output them to web pages. For more on these tools, see pages 27-31
the online help.

P Microzoft Outlook Express

Metscape Meszenger

To e-mail a template:

1 Click the Share: E-mail button on the
Command panel.

2 Click Send.

the Mail client drop-down list for help on

‘T.\i’ Tip: Select your default e-mail client from
how to set it to work properly.

To fax a template:

1 Click the Share: Fax button on the
Command panel.

2 Set the desired Layout options.
3 Click Send.

% Tip: Microsoft Fax must be installed first
\2' before you can use this feature.

To output a template as a Web page:

1 Click the Share: Web Page button on the
Command panel.

2 Setup the web page’s parameters (i.e.
number of rows and columns of the
images to display per web page).

3 Select To Mail from the Destination drop-
down menu.

4  Click Apply.
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Glossary

Album
A database that displays a visual representation of
image files analogous to a real world photo album.

Clone
Copies areas of an image onto the same image or
onto another.

Command panel

The large panel on the left side of the Photo
Express interface that holds all the commands and
functions.

Custom tab
Contains options of a selected tool or effect that
you can modify to better suit your needs.

Decoration
Contains tools and effects that can add creative
touches to simple images and enhance them.

Edges
A special effect that lets you add torn paper edges
to the borders of a picture.

Effects

Tools that you can use to enhance your pictures or
modify their appearance according to your
purpose.

Express
Contains tools where you can quickly create
calendars, screen art, slide shows, and morphing.

Fill
The process of applying color into a region.

Frame
An effect that lets you put a picture frame around
yourimages.

Gradient
A gradual transition between two or more colors.

HTML

HTML is the dominant language for publishing
hypertext on the World Wide Web. It is a non-
proprietary format, based upon SGML and can be
created and processed in a wide range of tools
from simple plain text editors to sophisticated
WYSIWYG (What You See Is What You Get)
authoring tools. HTML uses tags like <h1>and </
h1> to structure text into headings, paragraphs,
lists, hypertext links and more.

Magic texture

Contains random color patterns that you can use to
fill an object or selection with, or use it as
background.

Morph

Smooth transformation of one image’s appearance
into another. It is simply a way of processing a
warping sequence, creating an animated image.

Object

An identifiable component that is self-contained. In
Photo Express there are image, frame, shadow,
text, and background objects (and a few others),
each with their own characteristics and attributes.

Options panel

This is located at the right side of the Photo
Express program Ul (User Interface). This is where
you can modify the attributes of a selected tool in
order to achieve desired results.

Paint tools
Offers a range of brushes you can use to apply
“electronic paint”to your images.

Presets

Settings of different effects and functions provided
in Photo Express that appear as thumbnails in the
panel. You can quickly enhance your image by
simply clicking and dragging or double-clicking a
thumbnail to apply to your image.



Project Tab
This tab contains fun projects and useful tem-
plates for creative expression.

Props
Provides objects that you can add to your projects
that will make them more interesting and fun.

Retouch tools

Tools that let you fix ‘broken’ or damaged photos,
such as repairing tears, removing redeye, and
cleaning up scratches.

Screen Saver

Screen Savers are moving images that, in the bad
old days, prevented damage to your monitor
whenever you left your computer idle for a long
time.

Selection

Selections and selection tools are used to create
areas of an image that can be modified indepen-
dently of the rest of an image. Selections can be
drawn by hand, chosen by color or shape, or made
based on a preset grayscale mask. Selection
areas can be converted to objects.

Share

This button contains tools for outputting your
photos or projects. You can save or send them to
friends via E-mail, by Fax, or output them to an
HTML file.

Shortcut Bar

This toolbar, located at the bottom of the Photo
Express workspace, contains commonly used
menu commands for easy access.

Slide Show

This button displays the files from an album in an
on screen slide show. You can define how the slide
show is presented by setting the transition effects,
the sound track, and the delay timing.

Soft edge

Adds a soft edge to the brush or selection area.
The higher the value the more blending of the
edges.

Templates

Templates are project designs that are most
commonly used. By creating templates, you will be
able to save time in the design stage. You can
easily and quickly plug in desired images and text
to your project.

Thumbnail
A small, low resolution representation of an image.

Thumbnail scroll

A small window located at the bottom left of your
screen. This holds all the images and projects that
you have open at this session. You can click the
red arrow to unroll the scroll and choose the image
you want to currently work on.

Toolbar

Located at the upper section of the program Ul that
contains the available tools of a selected com-
mand.

Touch-up
Fix imperfections in your photos.

Transparency

Specifies the visibility of one object or image over
another. It affects how much you can see through
an object or the intensity of an applied effect.







